
Units and Conversions 
 
Open the View Properties Dialog for this section.  Be sure to click the thumbtack icon in 
that form to keep it visible. 
 
1.  Enter the rule  area = length * width . 
 
2.  Switch to the Variable Sheet and enter input values of 3 for length and 4 for width.  
Solve and TK tells us that area is 12.  The units are implied by the equation. 
 
3.  Let's tell TK to do the calculation in inches.  Move to the unit column and enter in for 
both length and width and in^2 for area.  See the properties for the variable area.  Both 
the display and calculation units are listed as in^2. 
 

 
 
 
4.  Open the Unit Sheet and define a unit conversion.  In the From column, enter in.  In 
the To column, enter cm.  In the Multiply By column, enter 2.54. 
 
From To Multiply By Add Offset Comment
in cm 2.54  

 
5.  Go to the Variable Sheet and enter cm as the unit for length.  TK automatically 
changes the value in the input field.   
 
The calculation unit is still inches (in) but the display is now centimeters (cm). 
 



6.  Change the display unit for area to cm^2.  TK places a ? symbol next to the value.  
This indicates that TK does not know the conversion from in^2 to cm^2. 
 

 
 
7.  Go to the Unit Sheet and enter a second conversion from in^2 to cm^2.  Enter 2.54^2 
in the Multiply By column.  Go to the Variable Sheet to see that TK has made the 
conversion. 
 
8.  Go back to the Unit Sheet and define some more conversions: 
 
 cm to mm  (enter 10) 
 cm^2 to mm^2  (enter 100) 

ft to in  (enter 12) 
 ft^2 to in^2  (enter 144) 
 ft to cm  (TK automatically calculates this factor!) 
 
9.  Use the File Menu, select Save Window and save the Unit Sheet to a file called 
areaunit.  Later, we can merge this information into another model instead of retyping it. 
 
10. Switch back to the Variable Sheet and associate lists with each of the variables.  
(Remember how to do this?)  Go to the List Sheet.  The associated lists have the same 
display and calculation units as the variables on the Variable Sheet.   
 
11. Go back to the Variable Sheet and change the display unit for area to mm^2.  TK 
does the conversion.  Now return to the List Sheet and see that the list is still in the 
original units.  The units are linked only during creation of the list.  Any changes to either 
the variables' or the list's units are done independently. 
 



12. Use the Applications Menu to access the TK Library and select the Utilities Section.  
Then select the Units section and merge one of the Unit Sheets into the current model. 
 

 
 
 
Summary: 
 
• Your initial entry in the Unit field assigns both the calculation and display units to the 
variable.  Subsequent entries change only the display unit. 
• Units are not like variables.  They are simply text strings.  TK does not recognize that 
in^2 means "inches squared." 
• Conversion factors work in both directions.  If in to cm is defined, then TK can also 
convert cm to in. 
• Conversion factors can be chained.  Given in to cm and cm to mm, TK knows in to mm. 
• There are no built-in unit conversion factors.  You must define your own or merge in a 
Unit Sheet which was previously created.  See the TK Library or Units Import Wizard. 
• Lists can also have calculation and display units. 
• Associated lists initially take on the display and calculation units of the variables.  
However, subsequent changes ARE NOT linked. 
• Open the View Properties Dialog to get a better view of the units for all variables. 



 
If you make an error when initially entering a unit, DO NOT type over the mistake.  TK 
will interpret the initial entry as the calculation unit and then attempt to convert to the 
second entry as the display unit.  Blank the field using Edit Cut or use the spacebar. 
 
 
TK UNIT WIZARDS 
 
The Object Units Summary Wizard provides a listing of all possible units which are 
available for a particular variable.  The wizard displays the calculation and display units 
for the variable along with a listing of units.  You just pick the one you want and TK 
updates the Variable Sheet.  Rumor has it that TK6 will make this wizard obsolete… 
 
The Global Units Summary Wizard allows for global switching of units throughout the 
Variable Sheet.  You can define unit groupings (such as US and Metric) and swap 
between them. 
 
The Units Import Wizard presents categories of units to load into TK’s Units Sheet. 
 

 
 
 



Review Exercise 
 
Enter the following equations on the Rule Sheet. 
 
 loan = price - down 
 X = loan*(r/(1-(1+r)^-n)) 
 pk = X*((1+r)^-(n-k)-(1+r)^-(n-k+1))/r 
 ik = X - pk 
 T = X*n 
 Ti = T - loan 
 
You may recognize these formulas as those used for evaluating consumer loans. 
 
Here the variable sheet after reorganizing and the addition of comments. 
 
==================== VARIABLE SHEET ============================= 
St Input---- Name--- Output--- Unit----- Comment----------------- 
             price                       Price 
             down                        Down payment 
             loan                        Loan amount 
             r                           Interest rate 
             X                           Monthly payment 
             n                           Number of monthly payment 
             T                           Total of all payments 
             Ti                          Total interest paid 
             k                           Payment to be studied 
             pk                          Principal paid in kth payment 
             ik                          Interest paid in kth payment 
 
 
In this example, units play an important role.  As implied by the equations, the variable r 
is being calculated as the monthly interest rate in decimal form.  Unfortunately, we don't 
usually think in these terms.  Instead, we talk about annual rates in percents. 
 
Enter monthly as the unit for the variable r.  Go to the Unit Sheet and add the following 
conversion. 
 
 monthly to %/yr  (enter 1200 for the conversion factor) 
 
Go back to the Variable Sheet and change the display unit for r to %/yr.  Let's try it out 
on a few sample problems. 
 
 Given: 
  price = 24000 
  down = 6000 
  r = 10  (%/yr) 
  n = 48   (this is the term of the loan, in months) 
  k = 1  (this is the current month number) 
 
 



1.  What is the monthly payment and total interest on this loan? 
 
2.  The buyer can only afford payments of $425 per month.  What interest rate would 
make this possible?  What change does this make in the total cost of the loan? 
 
3.  The buyer negotiates the deal at 9% interest.  What monthly payment did they settle 
for?  List solve and set up a table showing the principal and interest paid in each of the 48 
payments.  Show these curves on both a line chart and a bar chart.  Try the stacked bar 
option. 
 
Save the file with the name Loan. 
 
 
Formats 
 
Numeric Formats are TK objects just like lists and tables.  Formats can be assigned to 
variables or lists or columns in tables.  A format can be assigned as the Global Format in 
the Options menu.  This format will then be assigned to all variables, lists and tables 
unless another format is specifically designated for those objects. 
 
For practice, create a format and assign it to a variable. 
 
 
Comments 
 
Comments are also TK objects.  Comments have several unique features.   
 
They can be linked by using an asterisk within a comment.  For example, if a comment 
includes the text *uts, you can navigate directly from the current comment to the “uts” 
comment using a right-click. 
 
Comments on the List Sheet have a dual role in that they are used as the plot legend text 
for those lists. 
 
We suggest that before you save a TK model, create a comment displaying the author, 
date, and some description of what the model does.  The next time the model is opened, 
the comment will be a nice summary. 
 
 



MathLook 
 
The MathLook View at the bottom of the TK screen automatically formats whichever 
rule or function statement is highlighted in the current sheet.  You can right-click in the 
MathLook View to copy the equation to paste into another program. 
 
TK Solver also includes a MathLook Sheet that formats multiple rules and can also 
include other graphics images.  Highlight rules on the rule sheet or functions and copy 
them.  Then paste them into MathLook and you will see them formatted.  MathLook is 
not intended for use as a report writer but rather a utility for converting formulas and 
collecting graphics prior to copying and pasting into reports. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Report Writing 
 
There are two approaches you can take in producing reports based on TK models. 
 
1. Copy and paste into Word or Excel. 

or 
2. Use the TK Report Writer (File – Create Report). 
 
Option 1 has several advantages.  You have complete control over what goes into the 
report.  If you Paste Special with the Paste Link option, the TK objects in the document 
will automatically update when you make changes to the model.  You can insert text 
wherever you like.  Option 1 was used to create these training documents. 
 
Option 2 can be more efficient, especially if you intend to include many different TK 
objects in the report.  The resulting report can be converted to an .RTF file that can be 
subsequently edited in Word but many of the graphical objects don’t make it cleanly 
through the conversion process so you may need to copy and paste those manually. 
 
 



Sample Exercise 
 
Create a TK Solver model using the following formulas. 
 

volume = 1/3 * pi() * radius^2 * height 
radius^2 + height^2 = slant^2 
surface = pi() * radius * slant 
tand(theta/2) = radius/height 

 
Assign units to each of the variables using “in” as the base unit of length and “deg” for 
the angle.  Merge in a unit sheet from the TK Library. 
 
Input 20 for the volume and 3 for the radius and solve. 
 
Use the List Solve Wizard to generate a table and plot of surface vs. radius as the radius 
ranges from 1 to 5 in steps of 0.2.  Assign formats to the columns of the table as well as 
the variables on the variable sheet. 
 
Use the Optimizer to determine the radius resulting in the minimum surface value. 
 
Copy the equations into MathLook. 
 
Add a comment to the model, organize the sheets and save the file as CONE. 
 
Create a report using File-Create Report. 
 
Copy the variable sheet and paste special, linking as a TKW Document Object in Word. 
Change the inputs in TK and solve.  Check to see that the variable sheet updated in Word.  
Try the same process with the plot. 
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Linking TK Solver Models with Excel 
 
TK Solver models can be linked with Excel spreadsheets for several purposes.  You can 
use Excel to build a custom interface/report for the TK model.  You can use Excel as a 
dashboard for linking multiple TK models together, where the results of one model might 
be used as inputs in others.  You can use TK Packager with a linked spreadsheet to create 
and distribute applications to end users with access to Excel (but not necessarily TK). 
 
The prerequisites for linking are as follows: 
 
The TK model file must be saved. 
The model must be configured with a particular set of inputs and outputs.  You cannot 
link a model that has no inputs or outputs. 
The model must solve without the use of a guess on the variable sheet.  Default first 
guesses on variable subsheets are ok.  Guesses based on other input variables can also be 
programmed in TK and triggered by default first guesses on variable subsheets. 
If list solving is required, the variable sheet must include the proper configuration. 
The TK model must not include any of the following functions: PROMPT, QUERY, 
MENU.  All such data gathering should be done in Excel. 
The TK model may include the error trapping functions (ERRMSG, DEBUG, 
PAUSEMSG) but they will be ignored in Excel.  Any reporting of messages should be 
programmed in the Excel interface. 
 
The TK Solver-Excel Toolkit installs as an Excel Add-in under the Tools menu.  A set of 
optional toolbar icons is available as well.  For this exercise, we start with a new 
spreadsheet.  With A1 as the active cell we click the Insert TK Model icon from the 
toolbar.  The Toolkit prompts for the name of the file.  Use the CONE model. 
 
 
 
 
We will load the cone model but before we do, we confirm the configuration of the TK 
variable sheet as we will need it for use in Excel.  When it solves as expected, we save it 
and it is ready for linking. 
 

 
 
 

Status Input Name Output Unit Comment
L

L

3

20

radius
height
slant
volume
surface
angle

2.12206591
3.67466512

34.6329028
109.452237

in
in
in
in^3
in^2
deg



The Wizard automatically displays those variables with inputs.  If you choose not to link 
any of these input variables, they will act like constants in the model.  You will not be 
able to change them from Excel.  In this exercise, we will use all the inputs and outputs. 
 
 

 
 
Click Next to accept the inputs and then the outputs. 
 
 

 
 



Because this model is set up for list solving, the link will solve for the variables on the 
variable sheet and also list solve. 
 
The next two forms allow you to link plots and tables.  Since our model has a plot, we 
will link it.  It is important to note that the tables and plots are not editable within Excel.  
If you would like to edit the data you must follow a separate process for linking the 
underlying lists.  For now, click Next to accept the default links until you come to the 
form with options involving units, comments, and formats. 
 
In this exercise, we will include the units from the TK model since our model has no 
comments. 
 

 
 
You are strongly advised to avoid the use of the TK formats when linking to Excel.  By 
accepting the formatted values, you are in effect losing the accuracy of the actual 
calculations.  This will have a serious impact on all subsequent calculations, including 
optimizations performed by the Excel Solver.  It is best to format the values in Excel and 
the full precision of the TK calculations will be retained.  For this reason, the Link 
Wizard defaults to no for the use of TK formatting. 
 
When you click the Finish button, the variables and plot appear.  Here are the variables. 
 

 

Input Value Unit Output Value Unit
radius 3 in height 2.122066 in
volume 20 in^3 slant 3.674665 in

surface 34.6329 in^2
angle 109.4522 deg



These variables are now directly linked with the TK Solver model.  Try changing the 
radius value from 3 to 4 and watch the outputs update. 
 

 
The Value column of the output variables contains formulas that link to TK.  Here is the 
formula for the height output...   
=TKSolverGetValue("height",TKHidden!$A$11:$A$12)  If you type over these formulas 
the link is destroyed. 
 
The Unit column provides a listing of available units for each variable, inputs and 
outputs.  These are the units from the TK Unit Sheet that are chained to the calculation 
unit for each variable. 
 

 
You can reference these linked cells from other formulas in Excel.  If you intend to do so, 
you should NOT include TK’s unit conversion feature when you link the model.  Your 
Excel formulas will not update in the proper units when the TK variable units are 
changed.   
 
Here’s a simple example.  Suppose you add a formula in Excel for calculating the mass 
of the cone.  Your formula would be a function of the volume.  Assuming you have used 
MathLook for Excel to you’re your cells, your formula might appear something like  
=volume*density . 
 

 
If you ask TK to switch the volume unit from in^3 to ft^3, the value will decrease by a 
factor of 12^3.  Then the mass value will also decrease by the same factor which would 
be confusing.  The TK cells all maintain unit integrity but the new Excel formulas you 
may add do not.  If you linked the units and then change your mind later, you can lock 
them up again in Excel using the Excel Toolkit Locking Option. 
 

Input Value Unit Output Value Unit
radius 4 in height 1.193662 in
volume 20 in^3 slant 4.174306 in

surface 52.45587 in^2
angle 146.7682 deg

Input Value Unit Output Value Unit
radius 101.6 mm height 1.193662 in
volume 20 in^3 slant 4.174306 in

surface 52.45587 in^2
angle 146.7682 deg

Input Value Unit Output Value Unit
radius 4 in height 1.193662 in
volume 20 in^3 slant 4.174306 in
density 70 lb/in^3 surface 52.45587 in^2

angle 146.7682 deg
mass 1400



Click the List Link icon to link the radius and surface lists from the CONE model.  When 
the form appears, note the two tabs for inputs and outputs.  Double-click in the range 
field for the radius list and Excel will prompt for the cell location where the radius list 
will begin. 
 
 
 
 
 
 
 
You can click directly in the spreadsheet and Excel will fill the form for you.  Repeat the 
process for the output list, surface.  Then click the OK button at the bottom of the list link 
form and the lists will appear. 
 
Change the value of the volume in the spreadsheet and watch the surface list update.  
Save the spreadsheet, then close it and return to TK Solver and File New to reset TK. 
 
 
Review Exercise 
 
This sample involves water flowing though a tube.  The resulting math model will 
compute the pressure drop due to friction as the water flows through the tube.  We will 
add unit conversions, a table, a plot, and then link it to Excel. 
 
Here are the equations to be used, starting with the fluid property functions: 

 
 
Here is the resulting variable sheet, with comments and units and sample inputs.  A 
default first guess of .001 works well for the friction factor, f.  Do you understand why a 
guess is required to solve for f?   
 
 

Rule
density = $satldens(3,'water,'T,T)
viscosity = $viscosity(3,'water,'T,T,'D,density)
q = w/density
V = 4*q/(pi()*D^2)
NRe = V*D*density/viscosity
1/sqrt(f) = -4*log(eps/(3.7*D)+(1.255/(NRe*sqrt(f))))
deltap/L = f*density*V^2/(D*16.085)
gradient = deltap/L



 
 
Use the Units Import Wizard to load up the Unit Sheet. 
 
Use the List Solve Wizard to create a table and plot of D and deltap as D goes from 0.1 to 
0.5.  Change the plot scaling to Y-log. 
 
 

 
 
Save the model and link it with Excel. 
 

St Input Name Output Unit Comment

F

60

0.2
0.0006
20
0.1

T
density
viscosity
D
eps
L
q
w
V
NRe
f
deltap
gradient

62.36
0.000753

6.236
3.183
52702
0.007127
27.996
1.4

oF
lb/ft^3
lb/ft-s
ft
ft
ft
ft^3/s
lb/s
ft/s

lbf/ft^2
lbf/ft^3

Friction Loss in a Straight Pipe
   Isothermal Turbulent Flow

Fluid temperature
Fluid density
Fluid viscosity
Inside pipe diameter
Pipe roughness
Pipe length
Volumetric rate of flow
Weight rate of flow
Linear velocity
Reynolds number
Friction factor
Pressure drop due to friction
Pressure drop gradient
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Here is the table after linking to Excel.  You can also link the lists interactively. 
 

 
 
Lists are a special type of object.  The most important trait is that their length can vary.  
Because of this, their location in Excel must be handled more carefully. 
 
The first step is to identify which lists to link as inputs. 
 
 

Input Value Unit Comment Output Value Unit Comment
T 60 oF Fluid temperature density 62.36407361 lb/ft^3 Fluid density
D 0.2 ft Inside pipe diameter viscosity 0.000753331 lb/ft-s Fluid viscosity
eps 0.0006 ft Pipe roughness w 6.236407361 lb/s Weight rate of flow
L 20 ft Pipe length V 3.183098862 ft/s Linear velocity
q 0.1 ft^3/s Volumetric rate of flow NRe 52702.18965 Reynolds number

f 0.007126549 Friction factor
deltap 27.99580516 lbf/ft^2 Pressure drop
gradient 1.399790258 lbf/ft^3 Pressure drop gradient



 
 
Check the box next to the list name to link as an input.  Then click in the List Range area 
and click the browse icon.  The wizard waits for you to click a cell in Excel and fills the 
cell range for you. 
 
 

 
 
This part of the process can be tricky because there are so many fields popping up on 
your screen.  Repeat the same process for the output list, deltap.  If you need to move the 
lists after linking, you can cut and paste them to a new location.  For example, it’s 
probably best to store the lists to the right of the variables and plots.  That way, you can 
format the column widths without affecting the other linked objects. 
 
You can test the list links the same way you tested the variables.  Try changing the 
second element in the D list from 0.12 to 0.11.  You will see the corresponding deltap 
value update. 
 
When you link lists you are linking a lot more cells to TK, so you can expect the solution 
process to slow a bit.  Keep this in mind as you design your applications.  You don’t want 
to link long lists unless they are absolutely required in Excel.  And remember that the 
Excel Solver will repeatedly update the entire list in solving for any variable, so that will 
perform slower if long lists are linked. 



 

 
 
Now that you have these lists in Excel, you can format them as you like.  You can also 
use the Excel graphing capability as an alternative to those in the TK Solver model.  
Click the Insert menu and select Chart to start the process. 
 
 

 

Input:D Output:deltap
0.1 1034.208213

0.12 396.961586
0.14 177.3807319
0.16 88.58682568
0.18 48.16188887
0.2 27.99580516

0.22 17.17724184
0.24 11.01933525
0.26 7.337679122
0.28 5.043363515
0.3 3.562070549

0.32 2.575987095
0.34 1.901810258
0.36 1.429936547
0.38 1.092720397
0.4 0.84722386

0.42 0.665501445
0.44 0.52895225
0.46 0.424941894
0.48 0.344729602
0.5 0.282166314
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Linking Several TK Models with Excel 
 
You may link more than one TK model to a single Excel spreadsheet.  In fact, this is an 
excellent way to do process modeling.  The results from one model can be used as the 
inputs for another, with everything linked and communicating within Excel. 
 
You can also link a single model two or more times to view as multiple cases for 
comparison. 
 
To link a second model, just position the cursor in a cell with room for your incoming 
variables and then launch the wizard by clicking on the Insert TK Model icon. 
 
Test this with a simple TK Solver model with a single equation such as a+b = c.  Link it 
twice in a single spreadsheet.  Reference the output from the first link in a formula for 
one of the inputs to the second link.  Here’s an example. 
 
 

 
 
The underlying TK model has the equation a+b = c with inputs for a and b and an output 
for c.  After linking the model twice, we edited the variable names in Excel and added a 
formula linking the output for c1 to the input for a2, =f3/2, where f3 is the cell containing 
the output for c1.  The shading is added for illustration only. 
 
Obviously, if you have formulas this simple you can easily put them into a single TK 
Solver model.  However, the process works the same regardless of the complexity of the 
underlying TK models. 
 
 
 
 
 

Input Value Output Value
a1 2 c1 6
b1 4

 
Input Value Output Value
a2 3 c2 7
b2 4


